Software User Guide

• Read all safety precautions thoroughly to ensure safe use.
• Types of software installed on your computer varies depending on the method of installation from the
Software CD-ROM. For details, see the “Camera User Guide”
• For information on the operating systems that support the Software CD-ROM, see the “Camera User
Guide”.

How to Use the Software User
Guide

Using These Manuals
The two manuals included are for your G700.

Display examples:

1. Understanding How to Use Your
Camera

The display examples may be different from actual
display screens.

“Camera User Guide” (Printed manual)

Terms:

This guide explains the usage and functions of
the camera. You will also see how to install the
provided software on your computer.

In this guide, still images and movies are
referred to as “images” or “files”.

Symbols:
This guide uses the following symbols and
conventions:

This indicates important notices and restrictions
for using this camera.

2. Downloading Images to Your
Computer
“Software User Guide”
*This manual (this file)

This indicates supplementary explanations and
useful tips about camera operations.

This guide explains how to download images
from the camera to your computer.
This indicates page(s) relevant to a particular
function. “GP. xx” is used to refer you to pages
in this manual.

This indicates terms that are useful for
understanding the explanations.

3. Displaying Images on Your
Computer
The provided software “MediaBrowser” (for
Windows only) allows you to display and edit
images on your computer.
For details on how to use MediaBrowser, click
the [?] button on the MediaBrowser window
and see the “Help”
For the latest information about MediaBrowser,
access the Web page of Pixela Co., Ltd. (http://
www.pixela.co.jp/oem/mediabrowser/e/).
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Chapter 1
Downloading Images
to Your Computer
(Windows)
This section explains how to download still images and movies to
your computer (Windows).

Downloading Images

• The names for DC Software items differ from
the names for Caplio Software items provided
with previous models as shown below.

There are two methods for downloading
images from the camera to your computer.

Caplio Software

1. Downloading images without using
image download software such as
DL‑10 (GP.6).
The camera is recognized by the computer
as a separate drive and appears on [My
Computer]. Select and copy images.

DC Software

RICOH Gate La

DL-10

Caplio Viewer

DU-10

Caplio Server

SR-10 (*)

Caplio Setting

ST-10 (*)

(*) Not used with this camera.

2. Use image downloading software such
as DL‑10 to download all images to the
computer (GP.7).

• When downloading images from your camera,
load a battery with adequate remaining power
in the camera.
• If there is an SD memory card in the camera,
images will be loaded from the card. If there is
no SD memory card in the camera, images will
be loaded from the internal memory on the
camera.
• The software included in the CD-ROM can only
be used with Windows.

To use DL‑10, DC Software must be installed.
For information on how to install
DC Software, see the “Camera User Guide”.

• Do not turn off the camera or disconnect the
USB cable during image transfer. The files will
not be written correctly.
• Do not use the computer to format the SD
memory card or the internal memory. Use the
camera to format the SD memory card or the
internal memory.
• Be sure to stop the connection before
removing the USB cable.
• The camera can not display pictures that
have been transferred to the computer using
“Windows Photo Gallery” (Windows Vista) or
“Windows Live Photo Gallery” (Windows 7) and
then copied from the computer to a memory
card which is subsequently inserted in the
camera.
• Only one Ricoh digital camera can be
connected to one computer. Do not connect
multiple Ricoh cameras to one computer at the
same time.



4.

Downloading Images Without
Using DL-10

1.

Make sure that the camera power is
off.

2.

Connect the accessory USB cable to
a USB port of your computer.

From the displayed drive, copy a
file to the desired location.
The figure below shows the folder
configuration of the drive.

When the contents of the internal memory
are displayed, the drive name is [RICOHDCI].

3.

Connect the USB cable to the USB
terminal of your camera.

• If a file with the same name already exists at
the destination, it is overwritten.
• If DC Software is installed, clear the check
box next to the [Saves automatically when
connected to USB] option in the DL-10 [Option
settings] dialog box.

Your camera turns on.
Your computer automatically reads the file
necessary for recognizing the camera as a
drive.
After this preparation, the camera is
displayed as a drive at [My Computer].

Example of the display in Windows XP



Downloading All Images
Using the DL-10 Software

If image transfer does not begin, please try
the following procedures:
• Click the [Save] button in the DL‑10
window.
• Restart your computer and perform
Steps 1 to 3 again.
• Confirm that the [Saves automatically
when connected to USB] checkbox in the
[Option settings] dialog box for DL‑10 is
selected.

DL-10 automatically creates a folder called
[Digital Camera] inside your [My Documents]
folder. Downloaded images are saved in
folders with the date of each shot, inside the
[Digital Camera] folder. (The files will continue
to be saved in the [Caplio] folder if you were
previously using Caplio Software.)
Set the correct date and time on the camera
before shooting.

1.

Make sure that the camera power is
off.

2.

Connect the USB cable to the USB
port of your computer.

3.

Connect the USB cable to the USB
terminal of your camera.

• When the [The same image will not be saved]
check box is selected in DL-10 [Option settings]
(GP.11), the total number of files that can
be transferred at one time is 999. To transfer
1000 files or more, transfer 999 files first and
then click [OK] when the dialog box with the
number of remaining files appears. After that,
click the [Save] button in the DL‑10 window
or reconnect the USB cable to transfer the
remaining files.
• Do not turn off the camera or disconnect
the USB cable during image transfer using
DL‑10 (when the message for receiving data is
displayed).

• The images on the computer are renamed
using consecutive file numbers; the file names
assigned by the camera are not used.
• Even when the storage folder is changed, the
file number will be continuous. The number
cannot be initialized.
• When transferring images to a computer
using DL-10, the files are assigned names like
[RIMG****.jpg] (**** indicates the number of
the image), even if [Card Sequence No.] is set
to [On].

The camera turns on, DL-10 starts, and the
DL-10 window appears.

• For details about DL‑10, see P.9.
• For details about the DL‑10 [Option settings]
dialog box, see P.11.
• To disconnect the camera from your computer,
see P.9.

Image transfer begins automatically.



Warning Messages Under
Windows XP Service Pack 3 and
Windows Vista Service Pack 2

If you clicked the [Keep Blocking] button:
Follow the steps below to check to see the
Windows Firewall settings.

1.

When software for your Ricoh digital camera
is used on a computer running Windows Vista
Service Pack 2 or on a computer with
Windows XP Service Pack 3 installed, a warning
message similar to the one shown below
may appear at software activation or USB
connection. Change the computer settings
while referring to the information below.
A screenshot of the warning message in
Windows XP is shown below.

Open the [Windows Firewall]
Control Panel.

Open the [Start] menu and select [Control
Panel], then double-click [Windows
Firewall] (if Windows Firewall is not
listed,click [Switch to Classic View] at
the top left corner of the Control Panel
window).

When warning messages appear:
After checking the program name and publisher,
click [Unblock].

2.

Allow the Ricoh application
Internet access.

If you do not recognize the program, you should
block it because it may be a virus. Click the [Keep
Blocking] button to prevent the program from
connecting to the Internet.

If you clicked the [Ask Me Later] button:
Each time the program is activated, the
[Windows Security Alert] window appears. Then
you can select [Unblock].

In the [Windows Firewall] dialog,click the
[Exceptions] tab and check whether DL-10
is listed under [Programs and Services]. If
it is, place a check in the check box next to
DL-10 and click OK. If it is not listed,click
[Add Program…] to add DL-10 to the list of
exceptions.



Windows 7 Security Warning

Detailed Instructions for DL‑10

On computers running Windows 7, you may
encounter the following warning when starting
Ricoh software for digital cameras either
manually or by connecting a camera:

Starting/Exiting DL‑10
Starting
DL‑10 is already installed with DC Software.

When warning messages appear:
After checking the program name and publisher,
click [Allow access].

Connecting the camera to your computer
automatically starts the software and begins
downloading of images from the camera.

Exiting
To exit DL-10, follow either of the steps below.
• Click the [MENU] button on the DL‑10
window and select [Exit] from the displayed
menu (see “The DL‑10 Window”).
• Right-click the DL‑10 icon on the task bar and
select [Exit] from the displayed menu.

Restarting

Disconnecting the Camera
from Your Computer

To restart DL‑10 after exiting, follow the steps
below.
• From the [Start] menu, select [All Programs]
or [Programs] then [DC Software] then
[DL‑10].

Before disconnecting the camera from the
computer, click the [Safely Remove Hardware]
or [Unplug or Eject Hardware] icon in the
taskbar (the illustration below shows the icon
for Windows XP) and select [Safely remove
USB Mass Storage Device] or [Stop USB Mass
Storage Device] from the menu that appears.
You can then disconnect the USB cable.

DL‑10 is not network-compatible. Use as a standalone application.

If the remove hardware icon is not displayed in
Windows 7, click the button in the taskbar.

• If the USB cable is disconnected without
disabling the connection, the Unsafe Removal
of Device screen may be displayed.
• Do not disconnect the USB cable during
image transfer. Check that image transfer is
completed and be sure to stop the connection
before removing the USB cable.



The DL‑10 Window

3	 [Application] Button
The application registered in [Option
settings] is started.

Once DL‑10 starts up, the following DL‑10
window appears on your computer screen.

4 [Minimize] Button
Minimizes the window and displays its icon
on the Windows task bar. If you click on the
icon, the window will be displayed again.
5	 Indicator
The “Indicator” lights if the camera is
connected via USB cable. When lit, if you
move the mouse pointer over the “Indicator”,
[Camera is being connected] appears. When
your camera is not connected, the “Indicator”
is grayed out, and if you move the mouse
pointer over it, [Camera is being connected]
does not appear.

1 [MENU] Button
Click this and the following menu appears.

[Option settings] Specifies where to save
images when downloading
all images and which
application to start after
images have been saved
or when the [Application]
button is clicked. (GP.11)
[Background
illustration
settings]

Changes the background
design in the DL-10 window.
(GP.12)

[CameraMemo]

Transfer images (GP.19) to
destinations selected based
on the presence or absence
of a memo (GP.12) and
memo contents.

[About]

Displays the version of DL‑10.

[Exit]

Closes DL‑10.

2	 [Save] Button
Click this and the images are downloaded
from your camera.

If the message indicating that [Connecting...
Press [Adj.] key to direct print] appears on the
camera picture display, do not click the [Save]
button.
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How to Use the [Option settings]
If you click the [MENU] button on the DL‑10 window and select
[Option settings] from the displayed menu, the [Option settings]
dialog box appears.

Note that uninstalling the software for earlier Ricoh cameras may
reset user preferences for DL‑10 or RICOH Gate La.
Item

Description
Select the check box to have images downloaded and saved automatically
in your computer when the camera is connected to your computer with the
USB cable.
If you deselect the check box, your images will not be downloaded
automatically when you connect your camera to the computer. For
downloading, activate DL-10 and click the [Save] button.

Initial Setting

1

[Saves
automatically
when connected
to USB]

2

[Destination folder] Specifies which folder to save your images in. The [Digital Camera] folder
inside [My Documents] is specified initially; if you want to change this, click
the [Browse...] button to display the dialog box and then specify the folder.

3

[Create folder]

Specifies how to create a folder.
[Not created]
Your downloaded images will all be saved in the folder specified in item
“2 [Destination folder]”.
[For each date photographed]
Creates a new folder assigning the date the images were shot as the folder
name, and saves images shot on the same day in the same folder.
For example, if shot on January 1, 2010: [20100101] folder
[For each time saved]
Creates a new folder each time and save images in the folder. If images are
saved more than once in a day, a new folder is created each time.
The folder name format is “Saving date + Underscore + Three-digit serial
number”.
For example, if you saved twice on January 1, 2010:
[20100101_001] folder, [20100101_002] folder

4

[The same image
will not be saved]

When this check box is selected, images once loaded into your computer are The same
not loaded again. This check box is enabled only when [Not created] or [For
image will not
each date photographed] is selected in [Create folder].
be saved
To allow this function to work properly, the camera date and time must be set
correctly.
When this check box is deselected, previously loaded images are loaded
again.
* If you were previously using Caplio Software, images will be downloaded
again if images downloaded using RICOH Gate La remain on the SD
memory card even if the [The same image will not be saved] checkbox for
the DL‑10 [Option settings] is selected.

5

[Application
software settings]

To start an application after loaded images have been saved, specify the
application name here. Click the [Browse...] button and select the application
in the displayed dialog box.

6

[Save and start
application
software]

When this is checked, the application specified above is started after the
images have been saved.
When this is unchecked, the application is not started.

7

[Camera's IP
Address]

Not used for this camera, but used for other Ricoh digital cameras. For details, 0.0.0.0
see the documentation that came with the camera.
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Save
automatically

———
Create a new
folder for
each date
photographed

———
Application is
started

How to Use the [Background
illustration settings]

Using [CameraMemo Settings]
Transfer images to destinations selected
based on the presence or absence of memos
and memo contents. Click the [MENU] button
and select [CameraMemo] to display the
[CameraMemo Settings] dialog.

You can select a background for the DL-10
window from three types of patterns.
If you click the [MENU] button on the DL-10
window and select [Background illustration
settings] from the displayed menu, the
[Background illustration settings] dialog box
appears.

1 [Transfer From]
Choose the source from [Memory Card
(specify drive or folder)] and [Digital Camera]
in the [Type] menu. If you select [Memory
card (specify drive or folder)], click the
[Browse...] button and navigate to the desired
source folder.

1 [Background illustration pattern]
Select the pattern you wish to use from the
three available.

2	 [Save To]
Click [Browse...] and choose the destination
for the transferred files. The destination type
is fixed and can not be changed.
3	 [Settings...]
Clicking this button displays the [Setting
Information] dialog, where you can adjust
each of the transfer settings listed below by
double-clicking the setting or by selecting
the setting and clicking [Change...].

2	 [Preview]
You can preview the pattern selected in
[Background illustration pattern].

12

[Overwrite and
save] (available
only when [Digital
Camera] is selected
for [Transfer From]

Downloading Images from an
SD Memory Card

Choose whether to include
images that have already
been transferred to the
destination. Select [Do
not save the same image]
to skip images that have
already been transferred.

It is possible to download images from an SD
memory card to computer via a PC card slot or
card reader.

[Export type]
Choose whether to
transfer all images or only
(available only
when [Memory
those with memos.
Card] is selected
for [Transfer From])
[Transfer mode]

Choose whether the subfolders in the destination
folder are named by
memo description or using
both memo item names
and descriptions.

[Launch
application]

Choose the application
that starts when transfer is
complete.

[Confirm File
Overwrite]

Choose whether a
confirmation dialog is
displayed before files in
the destination folder are
overwritten by transferred
files with the same name.
If you opt not to display
a confirmation dialog,
files will be overwritten
without warning. If [Digital
Camera] is selected
for [Transfer From], a
confirmation dialog
will only be displayed if
[Save the same image] is
selected.

Images in an SD Memory Card
Images are stored on an SD memory card in a
hierarchy, as shown here.

Image files

If you connect the camera or a card reader to a
computer and then directly display, edit or save
SD memory card images on the computer, you
may no longer be able to play back the images
on the camera. Download the images to the
computer before displaying, editing or saving
them.

Card Reader

4 [Begin Transfer]

This is a device connected to a computer to read
the contents of cards. In addition to the memory
card adapter-type, there are card readers into
which you can directly load an SD memory card.

Click this button to begin transfer (clicking
this button is the only way to begin transfer
using [CameraMemo Settings]).

Reserved characters (\ / ; ? * " < > |) are
automatically converted to underscores (“_”)
when memo item names and descriptions are
used as folder names.
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Chapter 2
Downloading Images
to Your Computer
(Macintosh)
This section explains how to download still images and movies to
your computer (Macintosh).

Although supplied software can not be used on the Macintosh,
Macintosh computers can be used to view the “Software User Guide”
(Acrobat Reader required under Mac OS 9).

4.

Connecting the Camera to a Com‑
puter and Downloading Images

1.

Make sure that the camera power is
off.

2.

Connect the accessory USB cable to
a USB port of your computer.

From the displayed drive, copy a
file to the desired location.
The figure below shows the folder
configuration in the drive.

When the contents of the internal memory
are displayed, the drive name is [RICOHDCI].

3.

• Do not turn off the camera or disconnect the
USB cable during image transfer. The files will
not be written correctly.
• Do not use the computer to format the SD
memory card or the internal memory. Use the
camera to format the SD memory card or the
internal memory.
• Be sure to stop the connection before
removing the USB cable.
• Only one Ricoh digital camera can be
connected to one computer. Do not connect
multiple Ricoh cameras to one computer at the
same time.

Connect the USB cable to the USB
terminal of your camera.

Your camera turns on.
Your computer automatically reads the file
necessary for recognizing the camera as a
drive.
After this preparation, the camera is
displayed as a drive on the Desktop.

• When downloading images from your camera,
load a battery with adequate remaining power
in the camera.
• If a file with the same name already exists at
the destination, it is overwritten. If you do not
want the file to be overwritten, rename the file
or transfer data to another folder.
• When an SD memory card is loaded, its files
are displayed. Otherwise, files in the internal
memory are displayed.
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Disconnecting the Camera
from Your Computer

Downloading Images from an
SD Memory Card

1.

Drag and drop the displayed drive
or volume icon to the [Trash] icon.

It is possible to download images from an SD
memory card to computer via a PC card slot or
card reader.

When a screen appears prompting you to
enter the administrator's password, enter
the password.

Images in an SD Memory Card

2.

Images are stored on an SD memory card in a
hierarchy, as shown here.

Unplug the USB cable.

• You can also select [Eject] from the [Special]
menu in Mac OS 9 or the [File] menu in
Mac OS X to cancel the connection.
• A warning may be displayed if the USB cable
is disconnected without first removing the
camera from the system as described above.
Be sure to remove the camera from the system
before disconnecting the cable.
• Confirm that transfer is complete before
removing the camera from the system and
disconnecting the cable.
• When the camera is connected to a Macintosh
computer, a “FINDER.DAT” or “.DS_Store” file
may be created which the camera will list as
an unmatched file. This file can be deleted
without risk.

Image files

If you connect the camera or a card reader to a
computer and then directly display, edit or save
SD memory card images on the computer, you
may no longer be able to play back the images
on the camera. Download the images to the
computer before displaying, editing or saving
them.

Card Reader
This is a device connected to a computer to read
the contents of cards. In addition to the memory
card adapter-type, there are card readers into
which you can directly load an SD memory card.
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Chapter 3
How to Use EC1
EC1 is an edit detection software program that allows you to check
and view whether still images taken using the G700 have been
processed or edited.

In order to carry out edit detection using EC1, you must set [Edit
Detection] to [On] in the camera’s shooting setting menu before
shooting and download the images to your computer.

Using the Edit Detection
Function

• Neither of the above icons is displayed
with images taken when [Edit Detection]
was set to [Off ] or images for which edit
detection is not possible.
• By double-clicking an image in the
Thumbnail View, you can open the
image using the linked viewer software.

You can only carry out edit detection using EC1
after setting [Edit Detection] to [On] on your
camera, shooting still images, and downloading
the images to your computer.

1.

Set [Edit Detection] to [On] in the
camera’s shooting setting menu,
and shoot still images.

• Edit detection is available only with
photographs taken using cameras equipped
with an edit detection function.
• Images for which the [Resize], [Contrast
Correction], or [Skew Correction] functions
have been used during playback mode will be
labeled as images that have been processed or
edited.
• When downloading images to your computer,
please use the method for downloading
shown in Chapter 1. Images downloaded
using different methods may be labeled as
processed or edited images even if they have
not been processed or edited.
For example, when you download images
to your computer using “Windows Photo
Gallery” for Windows Vista or “Windows Live
Photo Gallery” for Windows 7, a portion of the
shooting data is edited during the download
process. As a result, the images are labeled as
processed or edited images for EC1.
• Depending on the software you used to view
images after downloading them, the images
may be labeled as processed or edited images
if you viewed the images or image properties
before saving or closing them.

For operation procedures, see the “Camera
User Guide”.

2.

Download the still images shot
using your camera to your computer.

3.

Select [Programs] (or [All
Programs]) > [EC1] > [EC1] from the
Windows [Start] menu.

4.

From the EC1 Folder View, select the
folder for the downloaded images.
The JPEG images in the selected folder
will be loaded and the images will be
displayed in Thumbnail View after loading
is complete.

• For details about how to install EC1, see the
“Camera User Guide”.
• For details about downloading images to your
computer, see P.5.

Updating Folder Contents
Folder View

After adding, deleting, or renaming folders,
select [Reload] in the [View] menu to update
the folder and thumbnail lists.

Thumbnail View

•

is displayed with images that have
not been processed or edited after
shooting.
•
is displayed with images that have
been processed or edited after shooting.
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Chapter 4
Shooting with Camera
Memos
You can attach camera memos (information such as shooting
conditions) to the still images you shoot. This section explains
camera memos.

•
•
•
•

Be sure to set the date and time on the camera.
To use the camera memo function, DC Software must be installed.
Memos are not available with SD WORM memory cards.
The camera memo function is only for use with Windows.

Use ME1 to view and edit the memos that have been appended to
photographs (GP.40).

Section 1
About Camera Memos
Shooting with Camera Memos
The image file storing the image shot with a
digital camera has an area where additional
information can be stored. The camera memo
function uses this area to allow you to attach a
memo to the still image you shoot.

Image
Image file

Memos make photographs easy to identify and
classify.

Additional
information
Camera memo
• Photographer
• Location, etc.

• Memos can not be added to movies.
• Memos can not be added to photographs
taken with [On] or [WB-BKT] selected for [Auto
Bracket] in the camera shooting menu.

Memos
Memos consist of a list of “items” (tags), each with its own “description” (contents). Memos can be
added to photographs by pressing the ADJ./MEMO button and selecting the desired descriptions in
the camera memo dialog before shooting.
9999

1/2

Camera Memo

4:3 F

Filename/SAMPLE
Client
Company A
Const.type Foundation work
Location Exterior
Supervisor Beverly Beech
Affiliates Gamma Company

FILE LIST

Items

20

Memo On

Description

Using Memos

1.
2.

Create a memo list on the computer and transfer it to the camera (GP.23).
Use the supplied List Editor application to create and transfer to the camera a memo list file
(extension “.mta”) containing memo item names and descriptions.

Take photographs with memos (GP.27).
Press the ADJ./MEMO button to display the camera memo dialog (GP.27). After choosing
descriptions, press MENU/OK to create a memo which will be added to all new photographs (if
desired, the contents of the memo can be changed after shooting; GP.29).
The following types of memo are available:
1 Text (GP.23)

3. Location

Choose from up to 99 text descriptions created with the
List Editor.

1/2

+ Temporary

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom

01
02
03
04
05
06

Cancel

2	 Temporary memo (GP.30)

Execute

Camera Memo

Use the camera to create a temporary memo using
descriptions not included in the memo list. The new
descriptions are not stored in the memo list after the camera
is turned off.

A
H
O
V

B
I
P
W

(

)

D

C
J
Q
X

D
K
R
Y

< >

E
L
S
Z
[

Shift
Cancel

F
M
T
!
]

G
N
U
?
&

1 2 3 $ [Delete]
4 5 6 \ [Space]
7 8 9 0 / - +
@ # % | , . =
_ ” ’ ` ~ * ^
Set
Ok

00:00/00:30

3	 Voice memos (GP.33)

O

Record voice memos of up to 30 seconds in length.

Shutter button: Start
:Cancel

1/45

Camera Memo

4 Barcodes (GP.36)
Create temporary memos using text descriptions from
barcodes read using the camera.

Barcode
Const.type
Location
Supervisor
Affiliates

Filename/SAMPLE
1234567890
Foundation work
Exterior
Beverly Beech
Gamma Company

FILE LIST

Memo On

1/45

5	 Images (GP.38)
To use still images as reference images, include a description
with an image file name when creating the memo list.
Note that the image file must first be copied to the camera
memory card or internal memory.
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3.
4.

Transfer the photos to the computer (GP.5).
Copy the photos to the computer using the supplied DL-10 software.

View and edit memos (GP.40).
Use the supplied ME1 software to display
photographs, view and edit memos, and play voice
memos.

• Memos will be added to all photographs taken while a memo list file is present in the camera’s internal
memory or on the memory card inserted in the camera.
• For information on installing the supplied software, see the “Software User Guide”.
• The supplied software is available for Windows only.
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Section 2
Creating and Transferring a Memo List
Creating a Camera Memo List

The List Editor Dialog

To create a camera memo list, use the provided
software List Editor.

1
2

To create a memo list, first create a list of up to
20 items and then create up to 99 descriptions
for each item.
3

• A camera memo list file in CSV format created
by a different application can be read into the
List Editor and saved on an SD memory card
for use by the camera.
• To read a csv format camera memo list file into
List Editor, select [Open] from the [File] menu
of List Editor, and then specify the file name.

4
Item

Description

1 Menu bar

Operations that can be performed
using the menus include saving,
editing, and transferring memo lists.

2 Toolbar

On the Windows [Start] menu, select [All
Programs] or [Programs] then [Caplio Software]
then [List Editor] to start List Editor.

Click the icons in the toolbar for
quick access to the following menu
items:
•
[New]: Open a dialog where
you can create a new memo list.

Exiting List Editor

•

You can exit List Editor by clicking the [×]
(Close) button in the upper-right corner of the
window or by selecting [Exit] from the [File]
menu.

[Open]: Open a memo list
that you previously saved on the
computer.

•

[Save]: Save the memo list to
the computer.

•

[Cut]/
[Copy]/
[Paste]:
Cut, copy, or paste selected text.

•

[Transfer to Camera]: Copy the
memo list file to the [TEMPLATE]
folder in the camera’s internal
memory or on the memory card
currently inserted in the camera.

Starting and Exiting List Editor
Starting List Editor
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3 Item name
(GP.24)

Name items in the memo list. The
number of items can be selected
from 20, 10, and 5 using the [Number
of Items] option in the [File] menu.

4 Details
(GP.24)

Enter descriptions for the selected
item.

Using the List Editor
The List Editor is used to create a memo
list containing up to 20 items with up to 99
descriptions for each item.

1.

Item names can be up to 20 characters long. The
following characters can not be used: \ / : ? * " <
>|

Choose the number of items in the
memo list.

3.

Select [Number of Items] from the [File]
menu.

Choose the number of items from [5] (the
default setting), [10], and [20]. If desired,
the number of items can be changed after
the memo list is created; note, however,
that if the list contains more items than the
new maximum, the excess items will be
deleted.

2.

Enter descriptions.
Select a name in the item list and edit the
descriptions for the selected item.

Enter descriptions in the [Input] text
box, and click [Add] to add them to the
end of the input list. Changes to existing
descriptions can be made by clicking the
description and then clicking one of the
following buttons:
• [Edit]: Edit the selected description.
• [Delete]: Delete the selected description.
• [Up]/[Down]: Move the selected
description up or down in the input list.

Enter item names.

Descriptions can be up to 32 characters long. The
following characters can not be used: \ / : ? * " <
>|

Click an item number, enter a name in the
[Item name] text box, and click [Update]
to display the new name in the item list.
Follow the same procedure to change
existing item names.
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4.
5.

Complete the memo list.
Repeat Steps 2 and 3 to complete the
memo list.

To edit an existing memo list, open it using
the [Open] option in the [File] menu. After
editing the list, save it using the [Save]
option in the [File] menu or by clicking the
button in the toolbar.

Save the memo list.
Select [Save As] in the [File] menu (memo
lists can also be saved by clicking the
button in the toolbar).

Confirm that [mta Files (*.mta)] is selected
for [Save as type] (memo lists can be saved
as CSV files, but the mta format must be
used for memo lists intended for transfer
to the camera). After navigating to the
desired location and entering a file name,
click [Save] to save the memo list. File
names can be up to eight characters long.
Although lists can be transferred directly
to the camera without being saved, we
recommend that you save the file before
transfer.
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Transferring a Memo List File
to the Camera

Card Readers
A card reader can be used to copy a memo list
file directly to the camera from the computer.
Copy the file to the [TEMPLATE] folder on the
memory card. A [TEMPLATE] folder is created
automatically when a card is formatted in the
camera.

Memo list files can be transferred to the camera
from the List Editor or using a card reader.

The List Editor

1.

Start the List Editor and connect
the camera.
After starting the List Editor, connect the
camera as described on P.6. Exit DL-10 if
it starts when the camera is connected
(GP.9).

2.

3.
4.
5.

Transfer the memo list file.
Click the [ Transfer to Camera] icon in
the toolbar or select [Transfer to Camera]
in the [Tools] menu. If a memory card is
inserted in the camera, the file will be
transferred to the [TEMPLATE] folder on
the memory card; otherwise, it will be
transferred to the [TEMPLATE] folder in
internal memory.

Deleting Memo List Files From
Memory Cards

The file will only be transferred if the
destination device contains a [TEMPLATE]
folder. If the destination is a memory
card, be sure it has been formatted in the
camera.

To prevent memos from being added to
photographs, use a computer to delete all
“*.mta” files from the [TEMPLATE] folder on
the memory card or in the camera’s internal
memory. Memo list files can not be deleted
by formatting the memory card or internal
memory using the format option in the camera
setup menu.

Click [OK].
Exit the List Editor.
Select [Exit] from the [File] menu or click
the close box [×] at the top right corner of
the List Editor window.

Disconnect the camera.
Remove the camera from the system and
disconnect the USB cable as described
on P.9 (note that if the connection is not
terminated normally, the memo list file
may not be transferred to the camera). The
memo list will be available for use when
the camera is turned on.
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Section 3
Taking Photographs with Memos
Recording Memos with
Photographs

Multiple Memo List Files
If the camera contains more than one memo list
file, press DISP. to display a list of files. Press !
or " to highlight a file and press MENU/OK to
select.

Before proceeding, confirm that a memo list file
has been transferred to the camera’s internal
memory or to the memory card inserted in the
camera.

FILE LIST
01
02
03
04
05
06
07
08

Adding Memos to New Photos

1.

Select 5/V mode and press
ADJ./MEMO.
The camera memo dialog will be displayed.
1/2

Camera Memo

Memo On

While the camera memo dialog is
displayed, photos can still be taken by
pressing the shutter-release button.

3.
4.

Execute

• If [On] is selected for [Display Memo at Startup]
in the camera memo menu, the camera memo
dialog will be displayed automatically at
camera startup.
• Memos will be added to all photographs
taken while a memo list file is present on the
camera.  To prevent memos from being added
to photographs, use a computer to delete all
“*.mta” files from the [TEMPLATE] folder on
the memory card or in the camera’s internal
memory. Memo list files can not be deleted
by formatting the memory card or internal
memory using the format option in the camera
setup menu.

If the camera contains multiple memo list
files, the most recently-used file will be
displayed.

2.

SAMPLE01
SAMPLE02
SAMPLE03
SAMPLE04
SAMPLE05
SAMPLE06
SAMPLE07
SAMPLE08
Cancel

Filename/SAMPLE
Client
Company A
Const.type Foundation work
Location Exterior
Supervisor Beverly Beech
Affiliates Gamma Company

FILE LIST

1/2

Create a memo.
Choose descriptions as described on P.28.

Press MENU/OK.
Press MENU/OK to accept the current
memo.

Take photographs.
The memo will be added to all new photos.
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Choosing Descriptions

[Mode2]

Descriptions can be selected in the camera
memo dialog. The method used depends on
the option selected for [Camera Memo Mode] in
the camera memo menu.

When the camera memo dialog is first
displayed, the description for each item will be
set to the first entry in that item’s description
list. Press $ once to set the description for each
item to the second entry in the description
list, twice to set the description for each item
to the third entry in the description list, and
so on. Press # to return to the previous set of
descriptions.

[Mode1]

1.
2.

Highlight an item.
Press ! or " to highlight an item.

View descriptions.

Camera Memo

Press $ to view descriptions for the
highlighted item.
3. Location

Client
Const.type
Location
Supervisor
Affiliates

1/2

+ Temporary
01
02
03
04
05
06

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

3.
4.

1/45
Filename/SAMPLE
Company A
Foundation work
Exterior
Beverly Beech
Gamma Company

FILE LIST

Memo On

Shows the position of the current memo and
the total number of combinations available. In
this example, the current memo uses the first
combination.

Execute

Choose a description.

Press ! or " to choose the item displayed. The
descriptions for individual items can not be
selected separately.

Press ! or " to highlight a description
and press MENU/OK to select.

Complete the memo.
Repeat Steps 1–3 to choose descriptions
for the remaining items.

To skip to the previous or next combination
that contains a unique description for the item
selected for [Memo Skip] in the camera memo
menu, press and hold # or $. The following
table gives an example of the combinations that
would be skipped when [Item 1] is selected.

• The last option in the list of descriptions is
[No Setting]. Select this option to set the
description for the current item to [No Setting].
Note however that if [On] is selected for [Memo
Warning], a warning will be displayed and the
shutter release will be disabled if you attempt
to take a photograph with the description for
one or more memo items set to [No Setting].
The shutter release can be enabled by choosing
a description for the affected items.
• If [On] is selected for [Camera Memo 1 Auto
Delete], the description for the first memo
item will automatically be set to [No Setting]
when the camera is turned on, a photograph
is taken, or a memo list is transferred to the
camera. The shutter release can be enabled by
choosing a description for the first item.

Item Description 1 Description 2 Description 3 Description 4
1

A

A

A

B

The item used for [Memo Skip] can selected from
items 1–5.
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Viewing Memos

Editing Memos

Follow the steps below to view and edit photos
that have been added to photographs.

1.

Display the desired photo in
playback mode.
Photographs to which memos have been
added are indicated by a “MEMO” icon.

• Memos can not be deleted.
• Camera memos can only be edited as
described below when [Mode1] is selected for
[Camera Memo Mode] in the camera memo
menu. In Mode2, memos can be displayed by
pressing DISP. during playback but can not be
edited.

2.

The memo will be displayed as shown
below.
1/2

Camera Memo

Client
Const.type
Location
Supervisor
Affiliates

Viewing Memos

1.

Press ADJ./MEMO.

Display the desired photo in
playback mode.

Filename/SAMPLE
Company A
Foundation work
Exterior
Beverly Beech
Gamma Company

Photographs to which memos have been
added are indicated by a “MEMO” icon.

2.

Memo On

Press ADJ./MEMO.

3.

The memo will be displayed as shown
below. Press ! or " to view additional
data.
1/2

Camera Memo

Press ! or " to highlight an item and
press $ to view descriptions for the
highlighted item.
3. Location

Filename/SAMPLE
Client
Company A
Const.type Foundation work
Location Exterior
Supervisor Beverly Beech
Affiliates Gamma Company

1/2

+ Temporary
01
02
03
04
05
06

Memo On

3.

Select an item.

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

Press MENU/OK.

4.

Press MENU/OK to return to normal
playback.

5.
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Execute

Choose a description.
Press ! or " to highlight a description
and press MENU/OK to select.

Press MENU/OK.
Press MENU/OK to return to normal
playback.

3.

Creating a Temporary Memo
Memo descriptions can be created on the
camera (either by editing existing descriptions
or creating entirely new descriptions) and the
resulting “temporary memo” appended to new
photos. Temporary memos can be created in
both shooting and playback mode.

• Temporary memos are not stored in the memo
list after the camera is turned off.
• Temporary memos can be created using
barcodes (GP.36).
• Temporary memos are available only when
[Mode1] is selected for [Camera Memo Mode]
in the camera memo menu.

4.

Creating a Temporary Memo
To create a temporary memo, display the
camera memo dialog and follow the steps
below.

1.
2.

Press ! or " to highlight an item and
press $ to view descriptions for the
highlighted item.

Select [Temporary].

Create a temporary description.
An on-screen keyboard will be displayed.
Use the keyboard to enter a temporary
description as described on P.49.

A
H
O
V

B
I
P
W

(

)

D

Press ! or " to highlight [Temporary] and
press MENU/OK.
3. Location

C
J
Q
X

D
K
R
Y

E
L
S
Z
< > [

Shift
Cancel

F
M
T
!
]

G
N
U
?
&

1 2 3 $ [Delete]
4 5 6 \ [Space]
7 8 9 0 / - +
@ # % | , . =
_ ” ’ ` ~ * ^
Set
Ok

After entering the description, press ADJ./
MEMO to return to the description list.

1/2

+ Temporary

5.

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

Press # or $ to highlight [Yes] and press
MENU/OK.

Camera Memo

Select an item.

01
02
03
04
05
06

Select [Yes].

Execute
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Select the temporary description.
Press ! and " to highlight the temporary
description and press MENU/OK to select
(to exit without saving the temporary
description and restore the description
previously selected, press DISP.). Repeat
Steps 1–4 to create additional temporary
descriptions as desired.

Editing the Temporary Memo

1.

2.

Creating a Temporary Memo from an
Existing Memo

Select an item.

Create a temporary memo by editing an
existing memo.

In the camera memo dialog, press ! or "
to highlight an item for which you have
created a temporary description and press
$ to view descriptions for the highlighted
item.

1.

Select a temporary description.

2.

Temporary descriptions are indicated by a
“+”. Press ! or " to highlight a temporary
description and press $.
3. Location

1/2

3.

Select a description.
Press ! or " to highlight a description
and press $.
1/2

+ Temporary

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

Press ! or " to highlight an item in the
camera memo dialog and press $ to view
descriptions for the highlighted item.

3. Location

+ Temporary
01
02
03
04
05
06

Select an item.

01
02
03
04
05
06
Execute

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

Edit the description.

3.

Edit the description as described in Steps
3–5 of “Creating a Temporary Memo.”

Execute

Edit the description.
Edit the description as described in Steps
3–5 of “Creating a Temporary Memo.”

Edited descriptions are stored as a temporary
memo. The original descriptions are not affected.
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3.

Memo Increment
If a memo description ends in a number,
you can increase or decrease the number by
pressing ! or ".

Select a description that ends in a
number.
Press ! or " to highlight a description
that ends in a number and press $ to
display the memo increment dialog.
Camera Memo
No.102

Memo increment is available only when [Mode1]
is selected for [Camera Memo Mode] in the
camera memo menu.

Using Memo Increment
Transfer to the camera a memo list file
containing descriptions that end in numbers
and follow the steps below.

1.
2.

Cancel

Select [On] for [Memo Increment].

Change Number
Ok

A warning will sound if you select a
description that does not end in a number.

Select [On] for [Memo Increment] in the
camera memo menu.

4.

Select an item.
Press ! or " to highlight an item in the
camera memo dialog and press $ to view
descriptions for the highlighted item.

Edit the number.
Press ! or " to choose a new number and
press MENU/OK twice to return to shooting
mode. The new number will be recorded
with the next photograph taken.

The new number is stored as a temporary memo.
The original description is not affected.
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Voice Memos

Using Memo Increment with
Temporary Memos

Each item in a memo can have as a description
an audio recording of up to 30 seconds in
length. Voice memos can be created and edited
in both shooting and playback mode.

Memo increment can be used with temporary
memos.

1.

Create a temporary description
that ends in a number (GP.30).

2.

Select [On] for [Memo Increment].

3.

4.

• Voice recordings are deleted from the memo
list when the camera is turned off. Voice
recordings already stored in memos that have
been appended to photos are not affected.
• Voice memos can be played back on the
computer when photographs are displayed in
the supplied ME1 software.

Select [On] for [Memo Increment] in the
camera memo menu.

Select the item.
In the camera memo dialog, press ! or "
to highlight the item with the temporary
description you created in Step 1 and press
$ to view descriptions for the highlighted
item.

Recording Voice Memos

1.

Select the temporary description.
Temporary descriptions are indicated
by a “+”. Press ! or " to highlight the
description and press $ to display the
memo increment dialog.

2.

Camera Memo
No.102

Select an item.
Press ! or " to highlight an item in the
camera memo dialog and press $ to view
descriptions for the highlighted item.

Select [Record].
Press ! or " to highlight [Record] and
press MENU/OK to display the recording
dialog.
3. Location

1/2

+ Temporary

Cancel

5.

01
02
03
04
05
06

Change Number
Ok

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

Edit the number.
Press ! or " to choose a new number and
press MENU/OK twice to return to shooting
mode. The new number will be recorded
with the next photograph taken.
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Execute

3.

Record a voice memo.
Press the shutter-release button to begin
recording.

• Do not obstruct the microphone during
recording. Keep microphone within 20 cm
(7.8 in.) of the source.
• Voice memos are not available with matrix
barcodes. The [Record] option is not displayed
in the description list when a matrix barcode
type is selected.

00:00/00:30
O

Playing Voice Memos
Voice memos can only be played back in
playback mode.

Shutter button: Start
:Cancel

1.

Recording ends after 30 seconds or
when the shutter-release button is
pressed halfway. The description list
will be displayed with a $ icon next to
the [Record] option (in playback mode,
[Record] changes to [Playback]).
3. Location

In the camera memo dialog, press ! or "
to highlight an item marked with a v icon
and press $ to view descriptions for the
highlighted item.
3. Location

1/2

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

4.

01
02
03
04
05
06

2.

Press MENU/OK.
Items for which a recording exists are
indicated by a v icon in the camera memo
dialog.

Press ! or " to highlight [Playback] and
press $ to display the playback dialog.

00:00
Shutter button: Start
:Cancel

Memo On
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Execute

Select [Playback].

1/2

Filename/SAMPLE
Client
Company A
Const.type Foundation work
Location v
Supervisor Beverly Beech
Affiliates Gamma Company

FILE LIST

Playback
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

Execute

Camera Memo

1/2

+ Temporary

+ Temporary
01
02
03
04
05
06

Select an item for which a
recording exists.

3.

Play the recording.

Re-recording Voice Memos

Press the shutter-release button to play the
recording.

Follow the steps below to edit voice memos in
shooting mode.

Playback ends when the end of the
recording is reached or when the shutterrelease button is pressed halfway. A
confirmation dialog will be displayed.

1.

Select an item for which a
recording exists.
In the camera memo dialog, press ! or "
to highlight an item for which a recording
exists and press $ to view descriptions for
the highlighted item.

To re-record the memo as described in
Step 3 of “Recording Voice Memos,” press
# or $ to highlight [Yes] and press MENU/
OK. Select [No] to return to the description
list without modifying the recording.

3. Location

1/2

+ Temporary
01
02
03
04
05
06

Record
Exterior
Entryway
Kitchen
Living room
Bedroom
Bathroom
Cancel

2.

Execute

Select [Record].
Press ! or " to highlight [Record] and
press $ to display the recording dialog.
00:00/00:30
O

Shutter button: Start
:Cancel

Re-record the voice memo as described in
Step 3 of “Recording Voice Memos.”
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Registering Barcode Data as a
Temporary Memo

Reading a Barcode and Registering
Barcode Data

The camera can read barcodes and store the
data as temporary descriptions for temporary
memos. Barcodes can be read in both shooting
and playback mode.

Shooting Mode

1.
2.

• The camera can read linear barcodes of up to
32 digits and matrix barcodes of up to 2400
digits. The barcode type can be selected using
the [Barcode Type] option in the camera memo
menu.
• Voice memos are not available with matrix
barcodes. The [Record] option is not displayed
in the description list when a matrix barcode
type is selected.

Mode3

Point the camera toward the
barcode you want to read and press
the # button.

1/45

Camera Memo
Filename/SAMPLE
Barcode 1234567890
Const.type Foundation work
Location Exterior
Supervisor Beverly Beech
Affiliates Gamma Company

The [Barcode Mode] option in the camera
memo menu can be used to choose where
barcode data are stored.

Mode2

The [Camera Memo] screen appears.

The camera switches to macro mode and
reads the barcode data. When the camera
finishes reading the barcode, the data are
stored as a temporary description for the
first item in the memo.

Choosing a Barcode Mode

Mode1

Press the ADJ./MEMO button.

The barcode is stored in the memo list as
a temporary description for the first item.
This description is overwritten each time a
barcode is read.

FILE LIST

The first barcode read is stored in the memo
list as a temporary description for the first
item, the second barcode as a temporary
description for the second item, the third
barcode as a temporary description for
the third item, and the fourth barcode as a
temporary description for the fourth item.
These descriptions are overwritten in turn as
new barcodes are read.

Memo On

If the camera is unable to read the barcode
or if you wish to exit without reading the
barcode, press $ or DISP. to return to the
camera memo dialog. Press # to read the
barcode again.
Non-ASCII characters in the barcode data
will be replaced by asterisks (“*”).

This option only takes effect in shooting
mode. Up to fifty barcodes can be stored in
the memo list as temporary descriptions for
the first item. These data can be viewed in
the camera memo dialog before shooting but
can not be changed and are deleted after a
photograph is taken.

3.
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Read additional barcodes.
If [Mode2] or [Mode3] is selected for
[Barcode Mode], repeat Step 2 to read
additional barcodes.

4.

Press MENU/OK to accept the new
memo.

Non-ASCII characters in the barcode data
will be replaced by asterisks (“*”).

The new memo will be recorded with the
next photograph taken.
To delete barcodes read with [Mode3]
selected for [Barcode Mode], highlight the
first item in the camera memo dialog and
press $ to display the description list. Press
! or " to highlight [No Setting] and press
MENU/OK.

Playback Mode

1.
2.
3.
4.

5.

When [Barcode Mode] is set to
[Mode2], you can repeat Step 4 and
read additional barcodes.

6.

Press the MENU/OK button to
confirm the camera memo.

7.

Press the MENU/OK button.
The memo will be added to the
photograph.

Display a photograph.
Display a photograph to which you wish to
add barcode data.

• You cannot read the same barcode more than
once.
• If, after reading the barcode, you shoot a
picture or change modes and then read
another barcode, the previously registered
barcode data is overwritten.
• If you edited the camera memo before reading
a barcode, the changes to the camera memo
are not retained if the camera is unable to
read the barcode. However, voice memos are
retained.

Press the ADJ./MEMO button.
The [Camera Memo] screen appears.

Press the # button.
You can now read barcode data.

Point the camera toward the
barcode you want to read and press
the # button.
The camera switches to macro mode and
reads the barcode data. When the camera
finishes reading the barcode, the data are
stored as a temporary description for the
first item in the memo.
1/45

Camera Memo

Barcode
Const.type
Location
Supervisor
Affiliates

• You can edit the barcode data registered as a
temporary memo. (GP.31)
• The time available to read barcodes can be
selected using the [Scan Time] option in the
camera memo menu.

Filename/SAMPLE
1234567890
Foundation work
Exterior
Beverly Beech
Gamma Company

Ok

If the camera is unable to read the barcode
or if you wish to exit without reading the
barcode, press $ or DISP. to return to the
camera memo dialog. Press # to read the
barcode again.
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3.

Image Memos
To use still images as memos, include a
description with an image file name when
creating the memo list. Note that the image
file must first be copied to the camera memory
card or internal memory.

Copy the image to the camera.
Copy the image to the [TEMPLATE] folder
in internal memory or on the camera
memory card.

Image memos can be viewed only when [Mode2]
is selected for [Camera Memo Mode] in the
camera memo menu. No image will be displayed
if a file with the selected name can not be found.

First Steps

1.

Enter the image file name as a
description.
Using the supplied List Editor application,
enter the file name of the desired image as
a description for the last item in the item
list (GP.23).

Image memos must satisfy all the following
criteria:
• They must be JPEG images
• Dimensions: From 32 (width) by 32 (height)
pixels to 4000 (width) by 3000 (height) pixels;
the width in pixels must a multiple of 16, the
height a multiple of 16
• Color space: YCbCr 4 : 2 : 0
• They must be 12 MB or less in size

• Enter the file name as the description for the
last item in the item list. The image will not
be displayed if the file name is entered as a
description for other items in the list.
• Image memo file names must end in the “.jpg”
extension.

2.

Connect the camera to the
computer.
See “Downloading Images Without Using
DL-10“ (GP.6) for more information.
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Viewing Image Memos

Playback Mode
To view an image memo that has been
appended to a photograph, display the
photograph and press ADJ./MEMO.

Shooting Mode
To view image memos, press ADJ./MEMO in the
camera memo dialog. Press ADJ./MEMO again
to return to the camera memo dialog.
Camera Memo

1/45
Client
Const.type
Location
Supervisor
Affiliates

Filename/SAMPLE
Client
Company A
Const.type Foundation work
Location Exterior
Supervisor Beverly Beech
Affiliates Gamma Company

FILE LIST

Company A
Foundation work
Exterior
Beverly Beech
Gamma Company

ADJ./MEMO button

Memo On

ADJ./MEMO button

1/45

XXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXXX

Press !, ", #, or $ to return to playback and
display other photographs.

No image memo will be displayed if a file with
the selected name can not be found.
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Section 4
Viewing/Editing a Camera Memo
on a Computer
Using ME1

Editing Memos
To edit the memo for a selected photo, doubleclick the icon in the thumbnail list. The edit
dialog will be displayed.

Once photographs have been transferred to
the computer, the supplied ME1 software can
be used to display photographs, view and edit
memos, and play voice memos.
Select [Programs] (or [All Programs]) >
[DC Software] > [ME1] from the Windows [Start]
menu to start the software.

1
2

The ME1 Window
1

3
4
5

2

6
7
8
Item
3
Item

Description

1 Menu bar

Operations that can be performed
using the menus include printing and
viewing photographs.

2 Folder list

A list of the folders on the computer.
Click a folder to display any photographs
it contains in the thumbnail list.

3 Thumbnail A list of the photographs in the selected
list
folder. Double-click a thumbnail to
display the photograph full frame. The
following icons are displayed under the
photos in the thumbnail list:
•
(GPS icon): Double-click this icon
to display GPS data recorded with the
photo (not available with the G700).
If no GPS data are recorded with the
photo, this icon will be grayed out
and unavailable.
•

(memo icon): Double-click this
icon to edit the memo appended
to the photo. If no memo has been
added to the photo, this icon will be
grayed out and unavailable.
40

Description

1 Item

A list of the items in the memo.

2 Voice memo
icons

The icons for items that contain voice
memos are displayed in red.

3 Memo

The descriptions for the items in the
item list.

4 [Play Voice
Memo]
button

Click to play the voice memo for the
selected item.

5 Edit Memo

Lists the item name and description
for the item selected in the item
list. The name and description
can be edited by typing in the
corresponding text box (the
following characters can not be used:
\ / : ? * " < > |).

6 [Apply]
button

Click to apply the changes in the
[Edit Memo] panel.

7 [Save]
button

Save changes and close the edit
dialog.

8 [Cancel]
button

Close the edit dialog. Any changes
made since the last time you clicked
the [Apply] button will be lost.

Printing Memos with Photographs
Select [Print] in the [File] menu to print memos
with photographs. Printer settings can be
adjusted by selecting [Settings] in the [File]
menu.

• Photos can be printed without memos.
• The number of memo items that can be
printed with three photos on a single sheet
varies with printer settings.

Print Samples
Single photo printed with memo on an A4 sheet
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Two photos printed with memos on an A4 sheet
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Three photos printed with memos on an A4 sheet
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Section 5
Using Memos to Sort Photos
Using EX1

Starting and Exiting EX1

The supplied EX1 software can be used to:

EX1 for Server

• Rename photographs or organize
photographs into folders using memo
data, allowing you to get an idea of memo
contents from the image file names

When installed using the default installation
options, EX1 resides permanently in the system
tray. To close EX1, click the icon in the system
tray and select [Quit].

• Export memos in CSV, XML, or TXT format
EX1 is available in client and server versions. The
server version (“EX1 for Server”) continuously
monitors a selected source folder for new
images and automatically processes them as
they are added to the folder. The client version
(“EX1 for Client”) does not process images
automatically.
To restart EX1, select [Programs] (or [All
Programs]) > [EX1 for Server] from the Windows
[Start] menu.

EX1 Operation Flow

1.

Copy photos to the computer
(GP.5).

EX1 for Client
To adjust settings, select [Programs] (or [All
Programs]) > [EX1 for Client] > [Setting]
from the Windows [Start] menu. To process
photos, select [Programs] (or [All Programs]) >
[EX1 for Client] > [Transfer]. To exit EX1, close
the transfer settings dialog. EX1 will terminate
automatically when processing is complete.

Copy photographs with memos to the
computer, either using DL-10 or by another
method.

2.
3.

Adjust transfer settings (GP.43).
Choose source and destination folders.

Process photographs.
The server version of EX1 automatically
processes photos as they are added to the
source folder (GP.45); to process photos
using the client version, select [Programs]
(or [All Programs]) > [EX1 for Client] >
[Transfer] from the Windows [Start] menu
(GP.45).
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Transfer Settings

EX1 for Client
Select [Programs] (or [All Programs]) >
[EX1 for Client] > [Setting] from the Windows
[Start] menu.

EX1 for Server
Clicking the EX1 icon in the system tray with
the right mouse button displays the following
transfer settings dialog.

1

1
2
2
3
3
4
5
4

Item
Item

Description

1 Transfer
From

Click [Browse…] to choose the
watched folder.

2 Process

Choose how photographs will be
processed.
• Camera memo extraction: Rename
files according to memo contents
and transfer them to the selected
destination folder, or export memos
in CSV, XML, or TXT format.

1 Transfer From

Click [Browse…] to choose the
folder containing the images you
intend to process.

2 Process

Choose how photographs will
be processed as described under
“EX1 for Server.”

3 Save To

Click [Browse…] to choose a
destination folder.

4 [Display
Select this option to display
confirmation
a confirmation dialog before
dialog before
transfer begins (GP.45)
transfer begins]

• Camera memo category: Create subfolders in the selected destination
folder named according to memo
contents and transfer files to the
appropriate sub-folders.

5 [OK] button

Click [Detail...] to adjust settings for
the selected option (GP.44).
3 Save To

Description

Transfer photos. The original files
will be deleted when transfer
is complete. (The first time you
start EX1 for Client, this button is
displayed as [Begin Transfer].)

Click [Browse…] to choose a
destination folder.

4 [OK] button Save changes and exit.

If [Camera memo extraction] is selected for
[Process], reserved characters (\ / : ? * " < > |) are
automatically converted to underscores (“_”)
when memo item names and descriptions are
used as folder names.
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Process > Detail

Camera Memo Extraction > Export Format

Clicking [Detail...] in the [Process] panel displays
the following dialog.

Select the format or formats that will be used to
export memos. Memos will not exported if no
options are selected.
The items in the setting information list depend
on the option selected in the [Process] panel. To
change settings, highlight an item in the setting
information list and click [Change...].

Camera memo category > Transfer Mode

Camera Memo Extraction > Rename Syntax

Choose whether folder names will consist of
the item name and description separated by an
underscore (“_”) or simply the description.
Example: Given the following camera memo…

Choose the memo items that will be used to
rename files. If multiple items are selected, they
will be separated by an underscore (“_”) in the
file name.

Item Name

Description

Item 1

Description A

Item 2

Description B

Item 3

Description C

Item 4

Description D

…the following folders will be created using
the item names and descriptions:
Item 1_Description A
Item 1_Description B
Item 1_Description C
Item 1_Description D
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Processing Photos

Property

EX1 for Server

To open the EX1 for Server properties dialog,
right click the EX1 icon in the system tray.

If folder monitoring is enabled, EX1 will monitor
the folder selected in the transfer settings
dialog and automatically process images as
they are added to the folder. Disable folder
monitoring to prevent images from being
processed automatically.

1

2

EX1 for Client

Item

Select [Programs] (or [All Programs]) >
[EX1 for Client] > [Transfer] from the Windows
[Start] menu. If [Display confirmation dialog
before transfer begins] is selected in the
transfer options dialog, the following dialog
will be displayed. Click [Transfer] to transfer the
images.

Description

1 Setting for Choose whether folder monitoring is
application enabled by default.
launching
2 Enable the Choose whether a log file will be
output of
created when images are transferred.
transfer log • Browse…: Choose a destination for
the log file.
• Maximum file size: Choose the
maximum size for the log file.
• History of file number: Choose
the number of files included in the
transfer history.

The original files are deleted after transfer.

45

File Information

<?xml version="1.0" encoding="Shift_JIS"?>
<Exif>
<APP1>
<Exif_IFD>
<DateTimeOriginal>2010:10:10 00:00:00
</DateTimeOriginal>
</Exif_IFD>
<GPS_IFD>
<GPSLatitudeRef>N</GPSLatitudeRef>
<GPSLatitude>00:00:00</GPSLatitude>
<GPSLongitudeRef>E</GPSLongitudeRef>
<GPSLongitude>00:00:00</GPSLongitude>
</GPS_IFD>
</APP1>
<APP5>
<CameraMemo1>
<MemoItem1>Item 1</MemoItem1>
<MemoData1>Description A</MemoData1>
</CameraMemo1>
<CameraMemo2>
<MemoItem2>Item 2</MemoItem2>
<MemoData2>Description B</MemoData2>
</CameraMemo2>
<CameraMemo3>
<MemoItem3>Item 3</MemoItem3>
<MemoData3>Description C</MemoData3>
</CameraMemo3>
<CameraMemo4>
<MemoItem4>Item 4</MemoItem4>
<MemoData4>Description D</MemoData4>
</CameraMemo4>
<CameraMemo5>
<MemoItem5>Item 5</MemoItem5>
<MemoData5>Description E</MemoData5>
</CameraMemo5>
</APP5>
</Exif>

The information below is included in files
created using [Export Format].
This example assumes that the following file is
transferred:
File Description
Item

Content

Date of recording

2010.10.10 00:00:00

GPS data

None

Memo Contents
Item Name

Description

Item 1

Description A

Item 2

Description B

Item 3

Description C

Item 4

Description D

Item 5

Description E

XML Format
Main Tag Name

Content

DateTimeOriginal

Shooting date of the image file

GPSLatitudeRef

Latitude (N or S)

GPSLatitude

Latitude (Numeric value)

GPSLongitudeRef

Longitude (E or W)

GPSLatitude

Longitude (Numeric value)

CameraMemo1–
CameraMemo5

Item names and descriptions

MemoItem1–
MemoItem5

Item names

MemoData1–
MemoData5

Descriptions
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CSV Format

TXT Format

Main Tag Name

Content

Main Tag Name

Content

DateTimeOriginal

Shooting date of the image file

DateTimeOriginal

Shooting date of the image file

GPSLatitudeRef

Latitude (N or S)

GPSLatitudeRef

Latitude (N or S)

GPSLatitude

Latitude (Numeric value)

GPSLatitude

Latitude (Numeric value)

GPSLongitudeRef

Longitude (E or W)

GPSLongitudeRef

Longitude (E or W)

GPSLatitude

Longitude (Numeric value)

GPSLatitude

Longitude (Numeric value)

(Memo item
names and
descriptions)

The above information is
followed by the memo item
names and descriptions.

CameraMemo1–
CameraMemo5

Memo item names and
descriptions

[DateTimeOriginal]
2010:10:10 00:00:00
[GPSLatitudeRef ]
N
[GPSLatitude]
00:00:00
[GPSLongitudeRef ]
E
[GPSLatitude]
00:00:00
[CameraMemo1]
Item 1
Description A
[CameraMemo2]
Item 2
Description B
[CameraMemo3]
Item 3
Description C
[CameraMemo4]
Item 4
Description D
[CameraMemo5]
Item 5
Description E

DateTimeOriginal,2010:10:10 00:00:00
GPSLatitudeRef,N
GPSLatitude,00:00:00
GPSLongitudeRef,E
GPSLatitude,00:00:00
Item 1, Description A
Item 2, Description B
Item 3, Description C
Item 4, Description D
Item 5, Description E
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Appendices

How to Use the Keyboard
To use the keyboard, follow the steps below.
Memo area

Camera Memo

A
H
O
V

B
I
P
W

(

)

D

C
J
Q
X

D
K
R
Y

< >

E
L
S
Z
[

F
M
T
!
]

G
N
U
?
&

1 2 3 $ [Delete]
4 5 6 \ [Space]
7 8 9 0 / - +
@ # % | , . =
_ ” ’ ` ~ * ^

Shift
Cancel

Set
Ok
Keyboard area

1.

2.

Enter a description of up to 32 characters.
Highlight characters using !, ", #, or $ and press MENU/OK to enter the highlighted
character at the current cursor position (to delete the character at the current cursor position,
select [Delete]). Press D to shift between upper and lower case. To exit without changing the
description, press the DISP. button.

Press ADJ./MEMO.
Press ADJ./MEMO to save the description and exit the keyboard entry dialog.
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Troubleshooting
Problem 1 Cannot download images
Solution 1
Your camera may not be recognized correctly if you connect to the USB Port of your computer via a USB hub.
Follow the steps below to change the USB port.
• Connect your camera directly to the USB port of your computer.
• If there are several root hubs, change to another hub.
If you are using a non-USB hub, try connecting via a USB hub.
Solution 2
The battery in the camera may have worn out.
Before downloading images from your camera, load a battery with adequate remaining power in the
camera.
Solution 3
The free space on the hard disk in your computer may be insufficient.
Check whether the hard disk has sufficient space for running Windows, and whether the drive where
you are loading image files has the same capacity or more as that of the SD memory card inserted in
the camera.
Problem 2	 Even if you check [The same image will not be saved] in the DL-10 [Option settings], the
same images are loaded into your computer.
Solution
The camera's clock is incorrectly set or the camera's clock information has been reset.
To allow the [The same image will not be saved] function to work properly, the camera's clock
information must be set properly. Set it properly.
Problem 3	 Files loaded from the camera into the computer were deleted. You attempted to load
the same files from the camera again but failed.
Solution
If [The same image will not be saved] is checked in the DL-10 [Option settings], files loaded into your
computer once cannot be loaded again. In the DL-10 [Option settings], uncheck [The same image will
not be saved].
Problem 4 [Failed to save.] appears during image loading from the camera into your computer
Solution
Set the camera to playback mode and check that [Unmatched File] is not displayed for any file. If
[Unmatched File] is displayed, delete the file from the SD memory card or internal memory after
backing up all files on your computer. To back up the files in the camera, copy all files into your
computer directly by using a commercially-available card reader or by connecting the camera to the
computer using the USB cable provided.
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